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Introduction

Welcome to Excelsior grade2 for Windows.    You are using one of the most powerful 
classroom grade and student management systems.    You will find many operations in grade2 
that will help you use your time efficiently.

Some of the operations you will want to learn include:

Setting up your Class file grading structure to match your grading system.
Choosing the appropriate method of calculating your grades.
Printing Reports for students, parents, and yourself.
Tracking Attendance on a daily basis.
Keeping Notes and Discipline records about your students.



Create a Class File

You can create a class file by pulling down the File menu and selecting New.    grade2 creates 
an UNTITLED Class File for you to enter your student and grade information.

To get started quickly, just:
1. Open one of our Template Class files such as QUARTERS, 
SIXWKS, or TRIMEST using the File menu and choosing Open.
Highlight the one that most closely matches when you report 
grades and press Enter.
2. Pull down the File menuand choose Save As.    Choose
the New button at the bottom of the window 
and the type in a name for your class file.
3. Enter students,
4. Enter your grade assignments,
5. And then enter the students' scores.
6. Save your Class File.

To customize the structure of a class file to match with your grading terms you will need to:
1. Pull down the File menu and choose New.
2. Define your Subjects, Intervals, Periods, and Categories
3. Enter your students.
4. Enter your grade assignments.
5. And then enter the students' scores.
6. Save your Class File.

You may also wish to see the following topics:

Choose the Right Grading Method for the Class
Set up the Grading Structure for a Class
Print Reports
Save a Class File



Set up the Grading Structure for a Class

You set up the structure of a Class file with the Define menu.    The structure is necessary for grade2 to find the 
correct and appropriate grade calculation for reporting purposes.    Below is an example of a portion of the class file 
structure for our example file `AHISTORY.G2C'.

The structure of your class file is based on the grade reporting times during the school year.    For example if you 
turn in grades at the end of a nine weeks term, at mid-semester, and at the end of the year.    Your class file should 
have 2 intervals in each subject (e.g. First Semester and Second Semester), and 2 grading periods in each interval 
(e.g. First nine weeks, Second nine weeks in First Semester, and Third nine weeks, Fourth nine weeks in Second 
Semester).    See the diagram below for the example structure.

Subject 1:    AMERICAN HISTORY
Interval 1:    1st SEMESTER Interval 2:    2nd SEMESTER
Period 1:    1st 9 WKS      Period 2:    2nd 9 WKS Period 1:    3rd 9 WKS      Period 2:    4th 9 WKS

If you calculate your final grade as an average of four quarter grades, your class file structure should look like the 
following.

Subject 1:    AMERICAN HISTORY
Interval 1:    YEAR
Period 1:    1st Quarter      Period 2:    2nd Quarter      Period 3:    3rd Quarter      Period 4:    4th Quarter

If your semester grade is a cumulative grade from the first day of class until the last day of class, then you just need 
one interval and one grading period.



Attendance Master List:
The Attendance Days defined in your Class File.    You can display the Master Attendance List for this grading 
period by pulling down the Define menu and choosing Daily Attendance.



ASCII Text File:
Information coded in the American Standard Code for Information Interchange (ASCII) and stored on your 
Computer system or on a floppy disk.



Blank:
Student has no score for an assignment.    Blanks are considered missing assignments and are not included in grade 
calculations.



Category:
Assignments or grades for which an overall grade is reported (e.g. Homework,    a grouping of similar Tests, 
Quizzes, etc.).



Class File:
Information about your students and grades stored on your computer system or a floppy disk by grade2.



Current:
The information highlighted under the cursor, in an active editing field, in the open window, in the grading column 
containing the cursor, or displayed on the Main Screen.    The current subject, grading interval, and grading period 
are displayed at the top of the window on the status line.    Current information is most important when printing and 
creating reports.



Data Transfer File:
Information to be transferred into or out of another Class File, other software, or computer, stored on your computer 
system or on a floppy disk.



Dialog Box:
A moveable window used to request information necessary to complete an action or function.



Edit Mode:
The way in which you want to enter a particular assignment or set of grades.    Your choices are to enter grades as 
numbers (Numeric) or as letter grades (Letter).



Edit Window:
An area on the screen used to enter and edit information.    The functions available in the window are listed as 
buttons at the bottom of the window.



Exempt Grade:
A special blank grade that you have decided not to require of a student.    Exempt grades are entered as an `X'.



Export:
Select information is save to an ASCII text file in the Exchange sub-directory for transferring purposes.



Export Format:
The layout for information set from your Class File to an ASCII text file.



File Extension:
The letters in a file name following the period (e.g. in the file name NEW.G2C, G2C is the file extension).

Some of the file extensions used in grade2 are listed below.

G2C          Class file extension
G2B          Backup Class file extension
G2F          Report Format file extension
G2S          Spooler file extension
DAT        Data Exchange file extension



Grade Information:
Information about your assignment or grade such as a description, the due date, the highest grade possible, and the 
category of the assignment.



Grades:
Actual numeric or letter values representing a student's achievement on an assignment or group of assignments.



Grading Formula:
An equation used by grade2 to actually calculate a set of grades.    The description of the grading formula is 
called the Grading Method, Calculation Method, or Method of Grading (MOG).



IBM CLAS:
IBM (International Business Machine) Classroom LAN (Local Area Network) Administration System.



Import:
Selected information transferred into your Class File from an ASCII text file.



Import Format:
The layout of information to be transferred into your Class File.



Interval:
The longest grading term during a school year for which you report grades such as a Semester or Trimester.



List Window:
An area on the screen used to list the information available.    The functions available in the window are presented as
buttons at the bottom of the window.



Mastery Level:
Level of competence required of a student for mastery of an assignment or objective.    

For the Subject Objectives the Mastery Level means what percentage of the correlated Interval Objectives does a 
student have to master to master this subject objective.

For the Interval Objectives the Mastery Level means what percentage of the correlated Period Objectives does a 
student have to master to master this interval objective.

For the Period Objectives the Mastery Level means what percentage of the correlated Grade Assignments does a 
student have to master to master this period objective.

For the Grade Assignments the Mastery Level means what score does a student have to make to master this grade 
assignment.



Mastery Score:
A student's score towards mastery of an objective based on the number and mastery weights of the assignments 
correlated to the objective.



Mastery Weight:
The importance of an assignment towards the mastery of an objective, or the importance of an objective towards the 
mastery of another objective.



Maximum Value:
The highest possible score for a grade assignment (doesn't include the extra credit points).



Notepad:
A special area in your Class File set aside for you to keep anecdotal information about your students.



Period:
The shortest grading term during a school year for which you report grades such as a Six Week period, a Nine Week 
period, or a Quarter.



Personal Information:
A student's individual information such as name, ID number, phone number, address and parent's name.



Personal Information Items:
Description of the data base items you want to keep about each student such as Name, ID number, Address, Phone 
number, or Book number.



Menu:
A list of operations or information available to you.



Qprint:
Send a copy of the window contents to the printer.    If you are in a List Window, Qprint will give you the entire list 
of defined items.    If you are in an Edit Window, Qprint will give you all the details about the item you are viewing 
or editing.



Regrade:
An assignment you allow a student to redo, or a test you allow a student to retake.



Report Editor:
A portion of grade2 that allows you to create any report with the information grade2 stores or calculates.



Report Format File:
The layout of a grade2 report stored on your computer system or on a floppy disk.



Score Weight:
The importance of the assignment of grade towards the calculation of a category or period grade.



Secondary Grading Method:
An alternate method of calculation your category, period, interval, or subject grades.



Workspace:
The area on the main screen set aside for entering grade and student information.    



Window:
An area on the computer screen used to present information and actions to you.



New File

Creates a blank workspace for entering new Class information.    Any existing information is removed from the 
workspace.    The workspace is given the name `Untitled.G2W'.    Our program default information is placed in the 
Untitled Class file such as our calculation methods, letter grade break point systems, etc.

If DEFAULT.G2C exists, the contents of the Class file DEFAULT will be copied into the workspace.    This allows 
you to have your personal default class information put in each new class file you create.



Open File

The Open command reads a stored Class File into the workspace and displays it for you to edit and enter 
information.    Any existing workspace information is replaced by the contents of the read Class File.    The 
workspace is given the name of the opened file with the file extension `.G2W'.



Open As Template File

The Open As Template command reads information from a stored Class File into the workspace and displays it for 
you to edit and enter information.    Any existing workspace information is replaced by the information from the read
Class File.    The workspace is given the name `UNTITLED' with the file extension `.G2W' (similar to File, New).

The information you can copy out of an existing class file into a new class file is the defined subjects, intervals, 
periods.    You can also choose to copy the categories and/or grade assignment information from the existing class 
file.    

This command allows you to create new class files with the same grading structure as other existing class files 
quickly and easily.



Close File

The Close command removes a Class File from the computer working area without writing the Class File.    
grade2 displays a dialog box if changes have been made to the Class File.    You can then choose to save the 
changes before closing the file, or you can close the file without saving the changes.

A New or Open command is required to fill and name the workspace following a Close.



Save the Class File or File Save

The Save command writes the existing workspace information to the hard disk or floppy disk (or other storage 
device) under the name of the workspace (e.g. AHISTORY.G2C) with the file extension `G2C'.    The previously 
saved version of the Class File is written to a backup file with the file extension `G2B'.



File Save As

The Save As command writes the existing workspace information to the hard drive or floppy disk (or other storage 
device) under a new Class File name that you specify.

See the following topic for more information about saving a class file:
Save As File



File Revert to Saved

The Revert to Saved command closes the current workspace without saving and opens the previously saved copy of 
the current Class Files.    Use this command when you have made changes to a class file that you don't want to save 
and wish to start editing again.



File Printer Setup

The Printer Setup commands allows you to choose the printer, the orientation of the page, and the paper size for the 
grade reports.    Change the information as you wish.    You can choose the printer you wish to use whether it is your 
Default printer or another printer on your computer system.    You can choose the orientation and paper size that is 
appropriate for your printer.    With the Options you can change the fineness and darkness of the text in your reports.



File Print

The print command provides a list of the Report Format Files available.    The Report Format Files are used to print 
information from the open Class File to the printer, to the screen for preview, or to a data exchange file.



File Exit

The Exit command ends an operation and removes the existing Class file from the workspace, then returns you to 
the operating system (or Microsoft Windows).



Edit Undo

The Undo command reverses your most recent edit operation in the open window or on the main screen of the 
current Class File.



Edit Clear

The Clear command removes the selected portion from the screen and leaves the space empty.    For example if you 
want to remove a grade from a column and not disturb the other grades in the column, use the Clear command.    

You can Clear    the grade under the cursor, the current grade column, or the grades for the current student.

The Delete key on your keyboard acts as a Clear current grade.



Edit Insert Grade

The Insert command creates a space in a column for information by moving the existing contents down in the 
column.    Insert moves the column contents from the cursor down one cell in the column.    This leaves a space 
under the cursor to enter the skipped value.



Edit Remove Grade

The Delete command allows you to remove a grade from the column and move the following portion of the column 
up one cell.    You can then correct a mistyped column by just removing the repeated grade and adjust the column 
upward.    



Edit Students

The Students command displays a list window containing the students entered in the current Class file.    You can 
add students, delete students, view a student's personal information, edit a student's personal information, insert a 
student, import or export the students, or quick print a list of the students.

See the following topic for more information about editing student personal records:
Student Information



Edit Notepad

The Notepad command displays a list window containing the available notepads for the current student.    You can 
add notepads, delete notepads, edit notepads, insert a notepad, view the contents of a particular notepad, import or 
export notepad information, or quick print the list of notepads.

See the following topic for more information about editing student notepads:
Student Notes



Edit Attendance

The Attendance command displays a list window containing the Attendance Dates that the current student has 
attendance information for.    You can edit an attendance record for a particular date, insert an attendance record, add 
an attendance record, delete an attendance record, view an attendance record, import or export the attendance 
records, or quick print a list of the attendance records for the current student.

See the following topic for more information about editing attendance records:
Student Attendance Information



Edit Discipline

The Discipline command displays a list window containing the Discipline Incidents for the current student.    You 
can edit a discipline record, insert a discipline record, add a discipline record, delete a discipline record, view a 
discipline record, import or export discipline records, or quick print a list of the discipline incidents for the current 
student.

See the following topic for more information about editing discipline records:
Discipline Information



Edit Regrades

The Regrades command displays a list window containing the assignments that you have allowed the current student
to redo and have documented as a Regrade.    You can edit a regrade record, insert a regrade record, add a regrade 
record, delete a regrade record, view a regrade record, import or export regrade records, or quick print a list of the 
regrade records for the current student.

See the following topic for more information about editing regrades:
Regrade Information



Edit Overwrite/Regrade

The Overwrite/Regrade command allows you to overwrite any grade that grade2 calculates for a particular 
student, or document a changed score that you entered for a particular student.    You can overwrite any of the 
category, period, interval, or subject grades that are calculated.    You can create a regrade record for any assignment 
score that you entered.    The overwritten grades and regrades    will appear bold in the column on the screen.

To remove an overwrite grade or regrade, you must use the Edit, Clear command.

See the following topics for more information about regrades:
Regrade Information
Edit Regrades



Numeric View

The Numeric view displays the numeric values in the columns on the main screen.



Letter View

The Letter view displays the letter equivalent of the numeric values in the columns on the main screen if you have 
assigned a Letter Grade Break Point system.



Mastery View

The Mastery view displays a mastery Yes or No in the columns on the main screen based on the mastery levels and 
weighting set in your objective structure.



Grades View

The Grades view shows the grade assignment scores in the columns on the main screen.    This is the default view 
for grade2.    You may reset to this view using the Reset Order command on the Utilities menu.



Categories View

The Categories view displays the calculated category grades in the columns on the main screen beginning with the 
first category grade in column one and continuing for the number of defined categories in the current grading period.



Periods View

The Periods view displays the calculated period grades in the columns on the main screen beginning with the first 
period grade in column one and continuing for the number of defined periods in the current grading interval.



Intervals View

The Intervals view displays the calculated interval grades in the columns on the main screen beginning with the first 
interval grade in column one and continuing for the number of defined intervals in the current subject.



Subjects View

The Subjects view displays the calculated subject grades in the columns on the main screen beginning with the first 
subject grade in column one and continuing for the number of defined subjects in the current Class file.



Period Objectives View

The Period Objectives view displays mastery Yes or No for the period objectives in the columns on the main screen 
beginning with the first period objective in column one and continuing for the number of defined period objectives 
in the current grading period.



Interval Objectives View

The Interval Objectives view displays mastery Yes or No for the interval objectives in the columns on the main 
screen beginning with the first interval objective in column one and continuing for the number of defined interval 
objectives in the current grading interval.



Subject Objectives View

The Subject Objectives view displays mastery Yes or No for the subject objectives in the columns on the main 
screen beginning with the first subject objective in column one and continuing for the number of defined subject 
objectives in the current subject.



Attendance View

The Attendance view displays the attendance information for each attendance date in the columns on the main 
screen beginning with the first attendance day in column one and continuing for each defined attendance day in the 
current grading period.



Select Category

The Category command allows you to choose to have the grade assignments from a particular category displayed on
the main screen.    The assignments are displayed in the columns beginning with the first assignment in column one 
and continuing for the number of defined grades in that particular category.

In the example above, when you choose OK only assignments in the Homework category will appear in the columns
on the screen.

You do not need to select a particular category before entering grade assignments in the category.



Select Period

The Select Period command allows you to choose the defined grading period you wish to view, edit, or print.    

In the example above, when you choose OK you will change to the First Six Weeks grading period.

When you change to a new grading period for entering grades, the previous grading periods are still stored in your 
class file.    Just use the Select menu to change to back to previous grading periods.



Select Interval

The Select Interval command allows you to choose the defined grading interval you wish to view, edit, or print.    

In the example above, when you choose OK you will change to the First Semester grading interval.

When you change to a new grading interval for entering grades, the previous grading intervals are still stored in your
class file.    Just use the Select menu to change to back to previous grading intervals.    When you change to a new 
grading interval you may need to change the grading period as well.



Select Subject

The Select Subject command allows you to choose the defined grading subject you wish to view, edit, or print.    

In the example above, when you choose OK you will change to the Language Arts subject.

When you select another subject you will stay in the same grading interval and the same grading period unless you 
change them with the Select menu.



Select Grades

The Select Grades commands allows you to choose the grade assignments that are displayed in the columns on the 
main screen.    For example you can choose to see assignment four in a column next to assignment ten.    

In the example above, when you choose OK grade2 will display only the assignment entitled `First Settlers in 
North America'.    

You can choose more than one assignment by tagging the other assignments you want.

Selecting grades is available for viewing purposes at this time.    This is not the way to choose which assignments 
will print on reports.    See the Report Editor.



Select Student Index

The Select Student Index command allows you to choose the student index item or items you want displayed on the 
screen.    You choose from the defined student personal items available in the Class file.

For example highlight the Student ID in the Student Index selection window.    When you press OK in this example, 
the Student ID numbers will appear in the student column instead of the Names.



Select Result Column

The Select Result Column allows you to choose the grade information you want displayed in the result column.    In 
the default view the current category grade is displayed.    You can choose to have the current period grade, current 
interval grade, or current subject grade displayed.

In the example window above the Result Column will show you the current category grades.



Enter Grade Assignments for a Class or Define Grades

The Define Grades command allows you to add new grade assignments to your class file or edit existing grade 
assignments for the current grading period.

This command displays a list window containing the assignments that you have defined for the current grading 
period.    You can edit a grade assignment, insert a grade assignment, add a grade assignment, delete a grade 
assignment, view a grade assignment, import or export grade assignments, or quick print a list of the grade 
assignments for the current grading period.

See the following topic for more information about defining grade assignments:
Grade Information



Define Categories

The Define Categories command allows you to add new grading categories to your class file or edit existing grading 
categories for the current grading period.

This command displays a list window containing the categories that you have defined for the current grading period. 
You can edit a category, insert a category, add a category, delete a category, view a category, import or export 
categories, or quick print a list of the categories for the current grading period.

See the following topic for more information about defining categories:
Category Information



Define Periods

The Define Periods command allows you to add new grading periods to your class file or edit existing grading 
periods for the current grading interval.

This command displays a list window containing the periods that you have defined for the current grading interval.   
You can edit a period, insert a period, add a period, delete a period, view a period, import or export periods, or quick
print a list of the periods for the current grading interval.

See the following topic for more information about defining periods:
Period Information



Define Intervals

The Define Intervals command allows you to add new grading intervals to your class file or edit existing grading 
intervals for the current subject.

This command displays a list window containing the intervals that you have defined for the current subject.    You 
can edit an interval, insert an interval, add an interval, delete an interval, view an interval, import or export intervals,
or quick print a list of the intervals for the current subject.

See the following topic for more information about defining intervals:
Interval Information



Define Subjects

The Define Subjects command allows you to add new subjects to your class file or edit existing subjects for the 
current class file.

This command displays a list window containing the subjects that you have defined for the current class file    You 
can edit a subject, insert a subject, add a subject, delete a subject, view a subject, import or export subjects, or quick 
print a list of the subjects for the current class file.

See the following topic for more information about defining subjects:
Subject Information



Define Period Objectives

The Define Period Objectives command allows you to add new period objectives to your class file or edit existing 
period objectives for the current grading period.

This command displays a list window containing the period objectives that you have defined for the current grading 
period    You can edit a period objective, insert a period objective, add a period objective, delete a period objective, 
view a period objective, import or export period objectives, or quick print a list of the period objectives for the 
current period.

See the following topic for more information about defining period objectives:
Period Objective Information



Define Interval Objectives

The Define Interval Objectives command allows you to add new interval objectives to your class file or edit existing
interval objectives for the current grading interval.

This command displays a list window containing the interval objectives that you have defined for the current 
grading interval.    You can edit an interval objective, insert an interval objective, add an interval objective, delete an 
interval objective, view an interval objective, import or export interval objectives, or quick print a list of the interval 
objectives for the current interval.

See the following topic for more information about defining interval objectives:
Interval Objective Information



Define Subject Objectives

The Define Subject Objectives command allows you to add new subject objectives to your class file or edit existing 
subject objectives for the current subject.

This command displays a list window containing the subject objectives that you have defined for the currentsubject   
You can edit a subject objective, insert a subject objective, add a subject objective, delete a subject objective, view a 
subject objective, import or export subject objectives, or quick print a list of the subject objectives for the current 
class file.

See the following topic for more information about defining subject objectives:
Subject Objective Information



Define General Information

The Define General Information command allows you to enter and edit some general information about your current
class file.    The information you can enter includes your name, the name of your class, the school name and address, 
and the school phone number.

This window allows you to enter and edit information about your
current class file.

The following is a description of the general information requested by grade2.

 School Year:    the school year date such as 1990-91.

 Class Name:    the description of your Class such as Algebra II or 5th Grade.

 Section:    the Section name or number of your Class such as section B or section 101.

 Period:    the time or class period when you meet for instruction such as 9:15 - 10 or 7th period.

 Grade Level:    the grade or level of your class such as 10th grade or 400 level.

 Teacher:    your name or the instructor's name if different.

 Teacher ID:    your ID (such as Social Security) used at school.

 Office/Room:    your office number or room number.

 Phone:    your phone number for school related calls, usually your office phone number or the school's phone 
number.    (Especially helpful on progress notices.)

 Conference:    the times you are available for conferences such as 2:30 - 3 PM MWF, or 3rd period TTh.

 Assistant:    your assistant's name such as your teaching assistant, your classroom aide, or your student teacher.

 Assistant Phone:    your assistant's phone number.

 Gradebook Number:    a number you may assign to your gradebook for record keeping purposes.

 School Name:    the name of your school.

 Address:    the street or mailing address of your school.

 City-St-Zip:    the city, state and zip-code of your school's street or mailing address.

The general information is used for header information on many of the grade2 reports.    The Class Name is used 
by grade2 to identify your class file in the Open File window.

You can import and export the general information, or quickly print the information on your printer.    



Define Personal Data Items

The Define Personal Data Items command allows you to add new data items to your student database in your current
class file or edit existing data items in your database for the current class file.    

This command displays a list window containing the personal data items that you have defined for the currentclass 
file.    You can edit a data item, insert a data item, add a data item, delete a data item, view a data item, import or 
export data items, or quick print a list of the personal data items for the current class file.

Using this command you can create a student database that matches your administrative system so you can import 
and export the student information.

See the following topic for more information about defining new personal data items:
Personal Data Information



Define Daily Attendance

The Define Daily Attendance command allows you to define the Attendance days for the current grading period.    
The attendance days belong to your Attendance Master List.

This command displays a list window containing the attendance days that you have defined for the 
currentgradingperiod.    You can edit an attendance day, insert an attendance day, add an attendance day, delete an 
attendance day, view an attendance day, import or export attendance days, or quick print a list of the attendance days
for the current grading period.

See the following topic for more information about defining Daily Attendance:
Daily Attendance Information



Define Letter Grades

The Define Letter Grades command allows you to define Letter Grade Break Point systems for the current class file. 
You can enter the letters you want and the value for each letter.    A letter grade break point system can have as many
as 15 letter breaks.

This command displays a list window containing the letter grade break point systems that have been defined for the 
currentclass file.    You can edit a letter grade break point system, insert a letter grade break point system, add a letter
grade break point system, delete a letter grade break point system, view a letter grade break point system, import or 
export letter grade systems, or quick print a list of the letter grade break point systems for the current class file.

If you want to define a letter grade system that uses special characters such as checks, you may need to change your 
grade sheet font to a font containing the symbols you want.    (If you want check marks you could use the Terminal 
font.)

See the following topic for more information about defining letter grade break point systems:
Letter Grade Information



Define Calculation Methods

The Define Calculation Methods command allows you to define grading methods for the current class file.    You can
define grading methods using variables recognized by grade2.    The program includes four grading methods 
defined for you: Averaging, Summation, Raw Score Conversion to Percent, and Summation Percentage.

This command displays a list window containing the calculation methods that have been defined for the currentclass 
file.    You can edit a calculation method, insert a calculation method, add a calculation method, delete a calculation 
method, view a calculation method, import or export calculation methods, or quick print a list of the calculation 
methods for the current class file.

See the following topic for more information:
Calculation Methods Information



Define Passwords

The Define Passwords command allows you to define three levels of passwords for controlling access to the current 
class file.    You can define a View Only password, an Edit Grades Only password, or an All Rights password.    

The View Only password allows someone to look at your class file information without making any changes or 
additions.    This would be appropriate to allow access to an administrator or school counselor.    

The Edit Grades Only password allows someone to enter and edit the students' scores on the main screen.    However
the person cannot edit or add grade assignments, or any other class file grading structure information.    This 
password is appropriate for a teaching assistant or grader. 

The All Rights password is your personal password.    You must assign this password if you want to use any 
passwords at all.

We recommend that you assign passwords for all three levels if you wish to use passwords.    Just enter a different 
password for each level.

NOTE: passwords are case sensitive (i.e. ace is not the same as ACE).    



Find Utility

The Find command initiates a search for a particular student or set of students.    You enter the search pattern (a set 
of characters) and choose to match the characters as the beginning characters of the current student item (Left to 
Right), or to match anywhere in the current student item (Internal).

The example find will look for the letter combination `son' anywhere in the students' names (if student names are 
showing in the student index column) when you choose the Internal button.    If you choose the Left to Right button 
grade2 will look for the first student whose last name begins with `son'.



Sort Utility

The Sort command organizes the students in a particular order based on student Personal 
ItemsDef_Personal_Information, GradesDef_Grades, or Incomplete students (i.e. students with blank or missing 
scores).    You select the direction of the sort, either Ascending or Descending. 

You can choose to use a two level sort.    This means if the first sort order finds two or more items that match, 
grade2 will use the second sort key to organize the items.

The example sort settings above will place students in alphabetical order based on their Name.

If you sort students and wish to have the students appear in the new order each time you open the class file, you 
need to save the new order.    See the Save Order Utility.



Save Order Utility

The Save Order command allows you to save the student order in the current class file.    This means that the 
students will appear in this order each time you open the class file and each time you use the Reset Order command.



Reset Order/Window Utility

The Reset Order command changes the main screen back to the default view and resets the student order.    The 
student index item is set back to the first student item (usually Name), places the grade assignments in the columns 
with the numeric values showing.    The cursor returns to the first grade column and the first student.

A fast way of activating the reset order command is to press function key F7.



Statistics Utility

The Statistics command displays statistics on the screen.    You can choose to show class statistics for the current 
grade column, class statistics for the current result column, or statistics for the current student.

The statistics displayed include the Mean, Standard Deviation, Variance, Highest grade, Lowest grade, Range, and 
the Number of grades.    



Bar Graph Utility

The Bar Graph command displays a bar graph of the letter grade distributions if you have assigned letter grade break
point systems to your grades.    The bar graph shows you the number of students receiving each letter grade.    You 
can choose to see a bar graph of the letter grades for current grade column, the current result column, or the current 
student.    



Import Utility

The Import command allows you to transfer information into the current class file from an ASCII text file (or data 
transfer file).    Sources for the data files may be other class files, other software packages such as word processors, 
or other administrative database systems.

The data is transferred into a particular window or grade column.    grade2 uses your Import format to transfer the
information into your class file properly.



Export Utility

The Export command allows you to transfer information into an    ASCII text file (or data transfer file) from the 
current class file.    You may use the data transfer file to send information to other class files, other software 
packages such as word processors, or other administrative database systems.

The data is transferred from a particular window or grade column to the data transfer file.    grade2 uses your 
Export format to write the information properly into your data transfer file.



Blanks to Zeros Utility

The Blanks to Zeros command allows you to quickly change the blank student scores to zeros and recalculate the 
grades.    You can choose to change the blanks to zeros in the current grade column, in all grades columns, or just for 
the current student.    Exempt gradees are not changed to zeros.

Once you change the blanks to zeros, the grade assignments are no longer considered missing assignments, and 
zeros are used in the grade calculations.



Quick Attendance Utility

The Quick Attendance command displays a list window containing your students with today's date.    You then 
highlight the appropriate students and enter their proper attendance codes (i.e. A - excused Absence, AU - 
Unexcused Absence, AS - School Absence, T - excused Tardy, TU - Unexcused Tardy).    

When you OK the window, grade2 adds today's date to your Attendance Master List and enters the attendance 
information into the proper attendance column.    grade2 also updates the students' personal attendance records. 

A quick way of activating the Quick Attendance command is to press function key F3.

See the following topic for information about using Quick Attendance:
Quick Attendance



School Absence
The student in officially in school but is not in your class.    The student may be on a field trip, in special testing, etc.



Report Editor Utility

The Report Editor command runs the grade2 Report Editor.    The Report Editor allows you to modify the 
existing reports or create your own reports.    All reports included with grade2 were created with the Report 
Editor.



Index Numbering Option

The Index Numbering command turns the student numbering (to the left of the student item) on or off.    The index 
numbering is on by default.    If you choose Index Numbering you turn it off.



Show Student Only Option

The Show Student Only command changes the display to show only the current student's scores and grades on the 
screen.    This option is valuable when wanting to show a student his/her grades, or to show a parent his/her child's 
grades.

The Show Student Only command acts as a toggle to turn on and off the current student only display.    You can also 
use the function key F6 to turn on and off the show student only mode.    Function key F7 will turn off the show 
student only mode.



Secondary Method Option

The Secondary Method command changes the grading method for the current student from your primary grading 
method to your defined secondary grading method.    grade2 places a small 2 in the result column between the 
numeric grade and the letter grade to remind you that the student's grade is being calculated by your secondary 
method.



File Locations Option

The File Locations command allows you to determine where grade2 stores and looks for various program files.    
The File Locations are set up for you when the program is installed.    However, you may change the file locations if 
you need to.    You choose where to place and look for class files, report format files, data exchange files, backup 
class files, and school report format files.    

The window above shows an example of the default file locations.    You may change these if you need to.



Modem Settings Option

The Modem Settings command sets the communication information for your modem.    You choose the Com port 
(usually 1) and the Dial type (either Tone or Pulse).

The communications port (Com port) on your machine is the serial port to which your modem is connect (usually 
the first port).    However, if you have your Mouse connect to your first serial port, your Com port for your modem 
would be 2.

The Dial type is determined by the phone system you use in your area.    If you can use a touch tone phone, then set 
your Dial type to Tone.    If you must use a rotary dial phone then you need to set your Dial type to Pulse.



Your Terms Option

The Your Terms command allows you to change the grade and objective structure terminology in the grade2 
program to match your grading system..    You can use alternate terms for subject, interval, period, category, grade, 
and objective.    You just need to enter the singular and plural terms that you wish to use in place of the default 
grade2 terminology.    Then your choice of terms will be used throughout the program.    Taking a few minutes 
now to change your terms will make it easier for you.    

The terms you may want to change:

Grade:    an assignment, activity, project, test, or other assessment you use to evaluate a student's academic progress.
Not to be confused with the student's score or "grade" on an assessment.

Category:    a grouping of assignments or assessments by type such as Homework, Projects, Laboratory 
Assignments, Tests, etc.

Period:    the shortest grading term in your school reporting structure such as a quarter, six weeks, nine weeks, etc.    
Not to be confused with a period of the school day.

Interval:    the longest grading term in your school reporting structure such as a semester, trimester, or the year.    
This is used to produce an accumulation grade for some or all of your grading periods.

Subject:    the academic course you are teaching to the group of students in this class.    Self-contained classroom 
teachers may have many subjects, while departmentalized classroom teachers may have only one subject.    This is 
used to produce an accumulation grade for all of your grading intervals.

Below are some examples of the terminology that may be used in grade2.

Our Terms Your Terms

Grade/Grades Assignment/Assignments Activity/Activities
Category/Categories Category/Categories Group/Groups
Period/Periods Quarter/Quarters Six Weeks/Six Weeks
Interval/Intervals Semester/Semesters Trimester/Trimesters
Subject/Subjects Subject/Subjects Course/Courses
Objective/Objectives Outcome/Outcomes Competency/Competencies



Set Colors Option

The Set Colors command allows you to change the colors that you see on the grade2 screen and in the windows.    
You can change the background, normal text, highlight, status lines, titles, borders, grade status, and grade cells.    
You can also choose to use our Excelsior default colors settings or the system default color settings.    



Grade Sheet Fonts Option

The Font command allows you to change the type and size of the text used in the program.    You can choose from 
any of the fonts installed in Microsoft Windows.    Just change the font, font style, size, effects, and color as you 
wish.

NOTE:    There may be some incompatible fonts and font sizes that are too large for grade2 installed on your 
computer system (WingDings for example).    If you change your fonts, please choose your font carefully.



Cell Sizes/Grade Undos Option

The Cell Sizes/Grade Undos command allows you to change the number of characters in the grade cells in the 
columns, the numeric portion of the result column, and the letter portion of the result column.    You can also change 
the number of changes that grade2 can save and cancel (the default is 150 undos).

Above is an example of the setting for the widths that you can use.    If you choose a large font, you may need to 
adjust the widths so that you display all the information in the columns.



Import Format Option

The Import Format command sets the delimiter, separator, and end-of-record characters for the data transfer files to 
be transferred into a grade2 class file.    

Above is the default import format used by grade2.    Below is an example record from a data file using the 
default format.

"Adams, Todd","98"

If you are transferring information from one place in a class file to another place, make sure the import format 
matches the export format.



Export Format Option

The Export Format command sets the delimiter, separator, and end-of-record characters for the data transfer files to 
be created by grade2 for transferring to other class files or other software packages.    

Above is the default export format used by grade2.    Below is an example record from a data file using the 
default format.

"Adams, Todd","98"

If you are transferring information from one place in a class file to another place, make sure the export format 
matches the import format.



Significant Digits Option

The Significant Digits command allows you to determine how many decimal places to use in all calculations made 
by grade2.    You can choose 1, 2, 3, or no decimal places for the calculations.    You can also choose to Round the
calculations or not (truncate).    Note if you choose 3 decimals places, you cannot round the calculations.

The default settings are 1 decimal place and rounding on.



Recalculate Option

The Recalculate command causes grade2 to recalculate all the grades at all levels.    grade2 automatically 
recalculates the grades as you enter new grades, and prompts you to recalculate when changes are made to the 
grading structure.    Yet the recalculate option is included to allow you to recalculate any time you wish.



Indexed Help

The Indexed Help command provides access to information organized by topic.    You can browse and select any 
Help topic you wish.



Keyboard Help

The Keyboard Help command provides access to information about the special keys and Mouse operations that will 
speed up your use of the program.



Using Help

The Using Help command provides access to information about how to use help in a Microsoft Windows 
application.



About grade2

The About grade2 command provides information about the version of grade2 you are using, your serial number, 
and your system memory.    This information may be requested by the technical support staff if you call with 
questions.

When you contact technical support please provide the following information:    

1. The version your are running.

2. Your Serial Number.

3. The amount of memory and system resources free.



Enter the Students' Scores

Once your class file structure is set up, there are students in your class file, and you have defined a grade 
assignment, you can enter grades or scores for the students.

To enter scores for the students:

1. Put your cursor at the top of the column where you want to enter scores.

2. Type in the numeric score or letter grade (determined by your Edit Mode of 
Numeric or Letter for the grade assignment) for the highlighted student and 
press Enter.

3. Repeat step 2 until all the students' scores are entered in the column.

If you want to enter scores for the students across the screen instead of down the columns, change to Show Student 
Only (Options menu).    Then when you type in a score and press Enter the cursor goes across to the next column 
instead of down to the next student.

You may wish to review the following topics:

Define Grades
Define Letter Grade Systems



Choose the Right Grading Methods for the Class

grade2 has four grading methods defined for you to use to calculate grades.    You can choose to use Averaging, 
Summation, Raw Score Conversion to Percent, or Summation Percentage.    Or, you can define your own grading 
method with the formula generator (see Define Calculation Methods).

In a class file, you are asked to choose a calculation method at four different levels.    You choose a Subject method 
of grading which determines how to combine interval grades to produce a subject grade.    You choose an Interval 
method of grading which determines how to combine period grades to produce an interval grade.    You choose a 
Period method of grading which determines how to combine category grades to produce a period grade.    You also 
choose a Category method of grading which determines how grade assignment scores are combined to produce a 
category grade.

You may use the same method of grading at all levels, such as Averaging.    Or you may need to choose different 
grading methods at the levels to produce the grades you want.    Below are some examples of how to set up some 
grading schemes.

Scheme 1: You are entering percentage grades in the grading columns (i.e. Max value is 100).    Use Averaging at all 
the levels.

Scheme 2: You are entering raw scores or points for the students in the grading columns, and you want to produce a 
percentage grade for the categories.    Use Raw Score Conversion or Summation Percentage for the category method 
of grading and use Averaging at period, interval, and subject levels.

Scheme 3: You are entering raw scores or points for the students in the grading columns.    You want the category 
grades to be total points earned in the category, yet you want to report a percentage grade for the period.    Use 
Summation for the category method of grading, use Raw Score Conversion, or Summation Percentage for the period
method of grading, and use Averaging for the interval and subject levels.

If you want to create your own method of grading, see the Define Calculation Methods topic.



Averaging
The grades are first multiplied by their individual weights (wt) and then added together.    The sum of the grades is 
then divided by the sum of the individual weights.    The resulting grade is then the statistical mean of the weighted 
individual grades.

Example calculation:    scores      75 wt. 1,    90 wt. 2,    84 wt. 3

Average = [(1x75) + (2x90) + (3x84)] / [1 + 2 + 3]    =    84.5



Summation
The grades are first multiplied by their individual weights (wt.) and then added together.    The resulting grade is the 
statistical total of the weighted individual grades.

Example calculation:      scores      75 wt.1,    90 wt. 2,    84 wt. 3

Sum = (1x75) + (2x90) + (3x84)    =    507



Raw Score Conversion to Percent
The grades are first converted to a percentage by dividing the grade by its max value.    The individual percentage 
scores are then multiplied by their individual weights (wt.) and added together.    This sum is then divided by the 
sum of the individual weights and multiplied by 100%.    The resulting grade is the statistical mean of the individual 
weighted percentage grades.

Example calculation:      scores    40 out of 45 wt. 1,    56 out of 60 wt. of 2,    34 out of 35 wt. 1

RSC% = [(1x(40/45)) + (2x(56/60)) + (1x(34/35))] / [1 + 2 + 1] x 100%    =    93.2



Summation Percentage
The grades are first multiplied by their individual weights (wt.) then added together to determine the number of 
points the student earned.    The max value for each grade is then multiplied by the individual weights (wt.) to 
determine the number of points possible.    Finally the number of points a student earned is divided by the number of
points possible and then multiplied by 100%.    The resulting grade is the percentage of the individual grades.

Example calculation:    scores    40 out of 45 wt. 1,    56 out of 60 wt. 2,    34 out of 35 wt. 1

S% = [(1x40) + (2x56) + (1x34)] / [(1x45) + (2x60) + (1x35)] x 100%    =    93.0



Add Students to a Class

You can add students to a Class by typing them in, by downloading from IBM CLAS (if you are on an IBM CLAS 
network system), or by importing from an ASCII data file.    

To enter students in your Class, you pull down the Edit menu and choose Students.    You will then have the list of 
students already in the class (if there are any).    You can then select the Add button to type in information for new 
students.    

You can choose the Import button if you want to transfer the new students in from an ASCII data file.    The ASCII 
data file can be created with a word processing program, a data base program, or a school administrative system.    
You will need to make sure that the student data items in your Class match with the items you are importing.    You 
can change the student data items in your Class using the Personal Data Items selection on the Define menu.

Refer to these other topics for more information:

Edit Students
Student Information
Define Personal Data Items



Print Reports

There are reports included with the program for you to use to report information to parents, students, and 
administrators.    There are also reports for you to use for your records.    Class reports are for printing grade and 
student information for groups of students in the current class file.    Student reports provide information about one 
particular student on each page.

You print reports by pulling down the File menu and choosing Print.    A list of the available reports appears in your 
window.    Choose the report you want and press OK.    You can then choose to print the report to your printer, to the 
screen, or to a data file.    

If the reports included with the program don't meet your needs, you can use the program Report Editor found on the 
Utilities menu.    You can then design reports any way you wish.    All of the reports included with the program were 
created with the Report Editor.    You may modify the included reports if you wish.

Other topics you may wish to view:

File Print
Report Editor Utility



Enter Discipline Information for a Student

You can keep discipline records for a student.    You can keep information about the incident that occurred, the date, 
and the action you took. 

To enter discipline information about a student:
1. Highlight the appropriate student.
2. Pull down the Edit menu and choose Discipline.
3. Choose the Add button at the bottom of the window.
4. Enter the information.
5. Choose OK.
6. Choose OK again.

If you need to document more information about the discipline incident, you may use a Notepad to store more 
information.

The discipline incidents are stored in a particular grading period.    When you change to a new grading period, the 
student will have no discipline information in the new grading period until you enter a new incident.

Other topics you may wish to view:
Keep Notes About Students
Discipline Information
Edit Discipline



Take Attendance

The fastest way to take Attendance for today is to use the Quick Attendance utility.    Quick Attendance brings up a 
window containing your students.    You then highlight the appropriate student and choose the correct attendance 
code.    When you OK the window, grade2 adds today's date to the Attendance Master List and creates the 
attendance records for the appropriate students.

If you need to take attendance for a day other than today, or the attendance days have been entered for the grading 
term, you should not use Quick Attendance.    To add a day to your Attendance Master List, use the Attendance 
selection on the Define menu.    Once you have defined an attendance day, a column becomes active with that date 
when you change the view to Attendance (i.e. View, Attendance).    Then you enter the appropriate attendance codes 
for the students in the correct day column.    (This process is very similar to entering grades in a column.)

You can check a student's attendance record by using the Attendance selection on the Edit menu.    You highlight the 
student you wish, pull down the Edit menu, and choose Attendance.    A list of the student's attendance information 
for this grading period appears in the window.    You can edit the information and/or add a comment if you wish.    
Some of our reports print the student's attendance records such as the Student Period Attendance Summary, the 
Student Progress Report, and the Period Attendance Summary.

Attendance days belong to a particular grading period.    When you change to a new grading period, there are no 
defined attendance days until you enter them.

Refer to these topics for more information:
Quick Attendance Utility
Define Daily Attendance
Daily Attendance Information
Student Attendance Information
Edit Attendance



Keep Notes About a Student

The program allows you to keep anecdotal records or notes about your students.    You can enter and edit the 
information using the Notepad selection on the Edit menu.    You can have as many different notepads about a 
student as you need.

To create a new notepad and enter notes about a student:

1. Highlight the appropriate student.
2. Pull down the Edit menu and choose Notepad.
3. Select the Add button at the bottom of a window.
4. Enter a title for the new notepad.
5. Enter the notes you want to keep about a student.
6. Choose OK.
7. Choose OK again.

Notice that musical notes appear to the right of the student's index item (probably his/her name).    The notes are a 
visual reminder that notepad information exists for the student.    You may edit the notepad information as you wish. 
And you can add as many other notepads as you wish.    

Notepads belong to a particular grading period.    When you change to a new grading period there will not be 
notepads until you add some notepads.

Refer to the following topic for more information:

Edit Notepads 



Track Learning Objectives

grade2 will track mastery of learning objectives for you if you enter your objectives and correlated your grade 
assignments to your objectives.    This is a very easy procedure.

First enter your Subject level learning objectives.    Often these are provided by your state education agency
or by your school district.

Then enter your Interval level learning objectives.    Often these are parts of the subject objectives.    Just 
make sure you correlate the interval objective to the appropriate subject objective.

Next enter your Period level learning objectives.    These objectives are often your unit learning objectives 
or your textbook chapter learning objectives.    Make sure you correlate each period objectives to the appropriate 
interval objective. 

Finally, when you define a grade assignment, correlate the assignment to the appropriate period objective.    
Then as you enter a score for an assignment, grade2 will also calculate the mastery of the particular learning 
objectives.

Other topics you may wish to view:

Define Subject Objectives
Subject Objective Information
Define Interval Objectives
Interval Objective Information
Define Period Objectives
Period Objectives Information
Define Grade
Grade Information
Correlating Grades to Objectives



Category Information

The following is a brief description of the information you enter for each category.

 Description:    You type in a description of the group of grade assignments that you want to call a category.    Enter a
Category Description that will mean something to you and your students on grade reports.    

 Method of Grading:    The way you want to calculate your Category grade such as Averaging, Summation, Raw 
Score Conversion to Percentage, Summation Percentage, or your formula.    The Method of Grading is very 
important for accurate category grades.    

 Category Weight:    The multiplier for the category grade, or the percentage of the period grade determined by the 
category grade.    For example, if you want all the categories to have equal weight towards the period grade, use a 
category weight of 1.    If you want the first category to count 15% towards the period grade, then use a weight of 15 
for the first period.

 Letter Grade Break Points (BPs):    The description of the Letter grade break point system you want grade2 to 
use when assigning letter grades to your numeric grades.    grade2 includes a set of standard letter grade break 
points.

 Category Curve Value:    The number of points you want to add to your category grades.    For example, with a 
curve value of 7 the program adds 7 points to each student's category grade.    

 Drop Low Grades:    The number of low grades you want to exclude from the category grade calculation.    For 
example, if you want to include all the student's grades except the lowest grade, then enter a `1' to drop only the 
lowest grade.    The default value is 0 (don't drop any low grades).    

 Drop High Grades:    The number of high grades you want to exclude from the category grade calculation.    For 
example, if you want to include all the student's grades except the highest grade, then enter a `1' to drop only the 
highest grade.    The default value is 0 (don't drop any high grades). 

 Secondary Grading Method:    grade2 allows you to calculate students' grades in two different ways, a primary 
grading method and a secondary grading method.    For the secondary grading method, you need to tell the program 
how to calculated the numeric grade.    grade2 also needs to know how to assign the letter grades and how to 
weigh the category. 



Grade Information

The following information fields are for you to enter your grade information.

 Description:    Example, Adverbs or Chapter 1 review questions.

 Due Date:    For example, Tues Oct 9

 First Category:    For example, Chapter 1 review questions were completed outside of class so it is a homework 
category.

 Maximum Value:    Highest score possible (for example, 100).

 Score Weight:    For example, assignment to have equal weight with all other assignments, use a score weight of 1.  
A score weight of 50 will count 50% towards the category grade.

 Objective:    The description of the defined period objective covered in the assignment or test.    For example, 
adverbs correlate to the Period Objective Parts of speech.

 Mastery Level:    For example, a 80 mastery means a student needs to score at least 80 on the assignment.

 Mastery Weight:    For example, weight (40) on adverb test means it counts 40% of the objective mastery.

 Edit Mode:    How you want to enter your grade, numeric or letter.

 Letter Grade BPs:    Which pre-defined Letter grade break point system do you want to use to assign letter grades 
to your scores?      An example is Normal Break Points.

 Extra Credit:    Is this grade treated as an extra credit grade?    Yes or No.

 Second Category:    For example, the Review question on Chapter 1 (Category - Homework) may also count as 
part of (Category - Weekly Quiz).

 Category Grade:    Type in the name of Category that is to become a single grade in another category.    Example, if
you want your homework grade to count as one test score, then define the Category Grade as homework and the 
First Category as Test.

 Secondary Grading Method:    You may wish to assign an additional method of grading for certain students.    If 
you select a secondary grading method, you will also need to define a score weight, mastery level and mastery 
weight.



Interval Information

The following is a list of the Interval information requested by grade2.

 Interval Description:    Description: an alphanumeric description of your grading Interval such as First Semester or
Second Trimester.    The program uses the Grading Interval Description on the grade reports.

 Interval Method of Grading:    The way you want to calculate your grading Interval (Semester, Trimester) grade 
such as Averaging, Summation, Raw Score Conversion to Percentage, Summation Percentage, or your formula.    
The Method of Grading is very important for accurate grading Interval grades.    

 Interval Weight:    The multiplier for the interval grade, or the percentage of the final grade determined by the 
interval grade.    For example, if you want all the grading intervals to have equal weight towards
the subject grade, use an interval weight of 1.    If you want the first interval to count 40% towards the subject grade, 
then use a weight of 40 for the first interval.    

 Interval Curve Value:    The number of points you want to add to your grading interval grades.    For example, with
a curve value of 3 grade2 adds 3 points to each student's interval grade.



Period Information

The following is a brief description of the Period Information requested by the program.

 Description:    an alphanumeric description of your grading period such as First Six Weeks, Third Quarter, Fourth 
Nine Weeks, etc.    grade2 uses the Period Description on the grade reports.

 Method of Grading:    The way you want to calculate your grading Period (6-wks, quarter) grade such as 
Averaging, Summation, Raw Score Conversion to Percentage, Summation Percentage, or your formula.    The 
Method of Grading is very important for accurate grading period grades.    

 Period Weight:    The multiplier for the period grade, or the percentage of the interval grade determined by the 
period grade.    For example, if you want all the grading periods to have equal weight towards the interval grade, use 
a period weight of 1.    If you want the first period to count 20% towards the interval grade, then use a weight of 20 
for the first period.    

 Curve Value:    The number of points you want to add to your grading period grades.    For example, with a curve 
value of 10 grade2 adds 10 points to each student's period grade.



Subject Information

The following is a brief description of the information requested by the program.

 Description:    An alphanumeric description of your academic subject or material such as Social Studies, Physical 
Science, Linear Algebra, or Art.    grade2 uses the Subject Description on the grade reports. 

 Method of Grading:    The way you want to calculate your Subject grade such as Averaging, Summation, Raw 
Score Conversion to Percentage, Summation Percentage, or your formula.    The Method of Grading is very 
important for accurate subject grades.    

 Curve Value:    The number of points you want the program to add to your subject grades.    For example, with a 
curve value of 5 grade2 adds 5 points to each student's subject grade.      



Save As File

The "Save as" Window Operation allows you to write the existing class file to the hard disk or floppy disk (or other 
storage device) under a new class file name.    This operation does not change the original class file.

 OK:    Quit editing, etc. and EXIT window.

 File Name:    Enter an 8 character or less DOS name for your class file.

 File Type:    Save Class files as .G2C files so that grade2 will recognize the file automatically.

 Directories:  grade2 looks for your Class file where you have set your File Locations.    You can change the 
directory and/or the drive.

 Cancel:    Selecting this button automatically closes the    window and stops the last operation.



Quick Attendance

Allows you to enter today's class attendance quickly and easily into today's attendance column on the screen.

Just move through your students and enter attendance information for the students that are absent or tardy.    
grade2 then creates an Attendance Record with today's date for each student with attendance information.    You 
can add a comment to the student's Attendance Record at another time. 

Highlight the students that are absent or tardy one at a time.    Clicking on Absent or Tardy results in an attendance 
code being placed by the highlighted student.    Clicking again changes the code.    With a keyboard, press A or T.    
NOTE: A double click of the mouse on the students name will also enter an absent code.    This code is changed by 
double clicking again.

When you finish, select OK.    Your attendance record is placed in the appropriate column on the main screen, under 
today's date.



Discipline Information

grade2 allows you to keep records of student discipline problems in a separate place other than the student's 
notepad.    The Discipline List Window contains the student's discipline record.    If the student has no information in 
the Window, then there is no information available.    A discipline record contains the date, the incident that 
occurred, the action you took, and a comment.

 Date:    The actual calendar date when the incident happened.

 Incident:    The related problem. For example, cheating on a test.

 Action Taken:    What you did about it.    For example, sent a note home.



Period Objective Information

The following information fields are listed for you to enter your Period objective information.

 Description:    Type in one of your daily or weekly objectives. 
    For example, Use of question marks or correct use of commas.

 Mastery Level:    The percentage score the student needs to
    reach in order to show mastery of the correlated objective. 

 Mastery Weight:    How important is this objective in determining mastery of the correlated Interval Objective?    
For example, 1 gives the grade equal mastery weight with other Period Objectives in determining mastery of the 
Interval Objective.

 Interval Objective:    Select the pre-defined Interval objective that correlates to the Period Objective .    For 
example: Demonstrate knowledge of standard uses of capitalization correlates to the Period objective - the first word
and all nouns in the salutation of a letter.



Student Information

This window contains a list of the selected student's Personal Items and the student's Status.

 Next:    Proceed to the next student in the List Data Window for additions, changes, etc.

 Prev:    Move back to the previous student in the List Data Window for changes, etc.

 Add:    Add a new student as the last selection in the List Information window.    Leaves the Edit Data window open 
to enter an additional student's data.

 Insert:    Add a new student before the current (highlighted) student in the List Information window.    Leaves the 
window open to enter an additional student's data.

If you have selected Add in the previous List Window.    You will be inserting at the end of the list.

 Delete:    Removes the current student in the Edit Data Window and adds the next student's data information.    BE 
CAREFUL USING THIS OPTION.

 Qprint:    Sends this student's personal information to your printer.    This is an easy way to print a student's personal
information for your files.

 Import:    Allows you to choose the data file containing your student information to transfer in.

 Export:    Allows you to transfer this student's information to a data file to be used in another software application.

 Dial Number:    Allows you to user your modem to call this student.

 Status:    If the student is going to be receiving grades, etc. then his/her status should be Active.    Any other status 
removes the student from the main screen display, reports, etc. and archives the student's information.



Student Attendance Information

You enter and edit the highlighted student's attendance information from the Student's Attendance Record.

 Select Date:    Toggle through the previously defined dates by clicking on the right arrows (_).    Select the correct 
attendance date.

 Select Attendance Code:    Toggle through the available codes (e.g., A: excused absence
AS: school absence    AU: unexcused absence    T: excused tardy TU: unexcused tardy).

 Comment:    Add a brief statement about the absence or tardy    which you recorded (e.g., sick with flu, dental 
appointment).



Regrade Information

In this Edit Window you can edit, add and insert the Re-taught Grade information.

  Grading Category:    Choose the category the changed grade assignment belongs to (e.g., Homework problems).

    Grade Description:    Choose the description of the grade assignment that was changed (e.g., Fraction problem).

    Old Grade:    Enter the Student's old grade on the assignment.

    Date:    Enter the date that the new grade was entered.

    Comment:    Enter comment to document the new grade situation (e.g., Attended a special session after school on 
fractions a re-test was given to measure results).

You can automatically enter this regrade information while changing the grade in the class main window.

1. Double click on the re-taught grade.
2. On the prompt window, select regrade.
3. In the new prompt window, enter your comment about the regrade and select OK.
4. You may now type in the re-taught grade.

grade2 now updates the student's Retaught Grade information Window with a description of the Grade, Category,
old grade entry date and your added comment.



Interval Objective Information

The following list of information fields are for you to enter your Interval objective information.

 Description:      In this field type in one of your Interval objectives.    For example: demonstrate knowledge of 
standard punctuation or divide whole numbers that have four or fewer digits.

 Mastery Level:    The percentage of the correlated period objectives the student needs to master in order to show 
mastery of this objective. 

 Mastery Weight:    How important is this objective in determining mastery of the correlated Subject Objective?    
For example: 1 gives the grade equal mastery weight with other Interval Objectives in determining mastery of the 
Subject Objective.

 Subject Objective:    Select the pre-defined Subject objective that correlates to the Interval Objective.    For 
example:    demonstrate knowledge of standard punctuation correlates to the Subject objective - English mechanics, 
or Understand metric measurements correlates to the Subject objective -    Understand measurements in either metric
or customary units.



Subject Objective Information

The following list of information fields are for you to enter your Subject objective information.

 Description:    Type in one of your Subject objectives.    For example: Demonstrate the ability to organize a written 
communication, or understand the concept of equivalency among fractions.

 Mastery Level:    The percentage score the student needs to reach in order to show mastery of the correlated 
objective. 

 Mastery Weight:    How important is this objective in determining mastery of the Subject?    For example: 1 gives 
the grade equal mastery weight with other Subject Objectives in determining mastery of the Subject.



Personal Data Information

In this window you can edit, add or insert a personal
information item.    The information grade2 needs about a Personal Information Item:

 Description: Name of the personal information item to be maintained.    For example, Name, Social security 
number or parents name.

 Type:    Character (Alphanumeric) or Numeric (contains numbers)

 Length:    Total number of characters.    For example, if your item is Name (Last, First), the item type is Character 
and the length is 30, then you can have up to 30 characters in an individual student's name.



Daily Attendance Information

The Attendance Day Window will allow you to Edit, Add, Insert and Delete dates from the Attendance Master list.    

 Date:    Enter the date as you want it to appear in your Attendance columns such as Thurs, Nov. 22.

 Comment:    Enter a comment you wish to attach to this day such as Holiday, Teacher In-Service, Snow Day, etc.



Letter Grade Information

This window allows you to add, edit and insert a new set of Letter Grade (BPs).    

 Description:    Enter a description for the Letter grade break point system you are entering such as School Letter 
Grades.

 Letter:    Enter the letter you want to appear as part of your letter grade system.    The letter can be    up to 5 
characters in length (example:    A+).    Start with the highest letter first and enter the letters in decreasing value.

 Value:    The numeric value assigned to the particular letter.    grade2 must have a unique value for each letter in 
your letter grade system.

If you want to use special characters in your letter grade system such as check marks, you may need to change your 
grade sheet font to a font containing the proper symbols.    (If you want to use check marks, you could use the 
Terminal font.)



Calculation Methods Information

In this window you can create a new formula, modify an existing formula, delete a formula or print a copy of the 
formula.

 Description:    Type in a meaningful description for your formula.    

 Line:    The remainder of this window has blank lines for you to use for defining your grading formula.    You use 
special codes for defining your grading formula.    For example, AVG[1,0,0] (average grade 1 through the current 
grade for this category).    



Keyboard Help

                APPLICATION                             PRESS 

Pull Down Menu Alt Key plus    F, E, V, S, D, U, O, H

Cancel ESC Key 

Tag Ctrl + Insert Keys

Move between buttons on Windows TAB Key - moves one space right

SHIFT + TAB - moves one space left

Select an item in a Window Underlined LETTER of the item 

Invokes button Selection on Menu Underlined letter of Window Button

Scrolling up, down, right or left Use Arrow Keys 

Move to Top of a Column Ctrl+Home Keys

Move to the First Column for student Home Key

Recall the Information in an Edited field Alt+Backspace Keys

Help Index F1

Notepad F2

Quick Attendance F3

Sort F4

Find F5

Show current student only F6

Reset F7

Category List window displayed F8

Grade Edit Information window displayed F9

Report Select and Print F10

                                                                                                                  Mouse Help                    

Usually selects or tags Single click of Mouse

Usually selects and invokes Double click of Mouse

Drag Hold button & move Mouse

Abort Click on Cancel

Accept change Click on OK



Import Help

You need to choose the name of the data file that contains the information (such as the student information, 
assignment information, or the category information) you want to import.    

By default grade2 looks for data files in your File Locations settings for the Exchange sub-directory.    You may 
need to change your drive and/or directory to find your data file if it is not in your Exchange directory.



Export Help

You need to enter a DOS file name for the data file you are creating to hold the information you are exporting.    The 
file name should be 8 characters or less with no spaces, asterisks, periods, commas, etc.    The file name should 
provide some information about the contents of the data file so it will be easy to retrieve the information at another 
time.

By default grade2 saves your data files in your File Locations settings for the Exchange sub-directory.    You may 
need to change your drive and/or directory to save your data file in another place.



Qprint Options Help

You can control the dithering and the intensity of the printing based on your printer.    Consult your Windows manual
for more information.



Correlate Grades to Objectives

You correlate a particular assignment to a particular Period Objective that you have previously defined in your class 
file.    All you need to do is choose the Period Objective, the Mastery Level, and the Mastery Weight of the 
assignment.

The Mastery level for an assignment is the score a student needs to make in order to show mastery of this 
assignment.    

The Mastery Weight of an assignment is how important is this assignment to the mastery of the correlated period 
objective.    We recommend that you set the Mastery Weight to 1 if you want the assignment to count towards 
mastery, or 0 if you don't want the assignment to count towards mastery.

You enter this information in the Define, Grades window.    You may wish to see the following topics for more 
information:

Tracking Learning Objectives
Define Grades
Grade Information




